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6	 Working with Tables
Basically everything in Excel is tables, except the diagrams. A spreadsheet is itself a large table. When 
I talk about tables, I mean defined regions in the spreadsheet with a group of data. This group of data 
has some column headers and maybe, but not necessarily, some row headers.

We have already worked a little with tables in connection with formatting. If you have read the section 
on formatting tables, you might remember that several things happened beyond giving the table some 
nice colours. 

6.1	 Create a Table

The starting point for the exercises in this book is a small list of different movies that I have in my DVD 
collection. The list should perhaps include 150 movies, but I am pretty sure that in that you would not 
want to do the exercise!

We therefore confine ourselves to five films, which should be enough to get an understanding of working 
with tables. With so few rows, it seems foolish to make grades and filterings, but I will ask you to imagine 
that we are doing the same with a long list. 

If you have a collection of movies, music or anything else, you could make a small index of it afterwards 
to practice what you have learned in this section.

1.	 To get some material to work with in the following exercises you must create a spreadsheet 
similar to the one shown in Figure 53. You are probably going to have to adjust the width of 
the columns to be able to view all of it.

Figure 53: Starting point for the exercise.

2.	 Place the cursor, so one of the cells inside the table is the active cell. 
3.	 In the Ribbon, ensure the Home Tab is selected, then click the button Format as Table.
4.	 Click on a table colour. You have now created your table.
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Figure 54: Sample table. Note that the Ribbon at the top has changed.

This table is the starting point for several exercises to come.

6.2	 Filtering

Once you have created a table, you have to use filters on it. You use filters to select and show certain 
data in the table, according to criteria which you have defined. 
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Excel operates with two different types of filters called “AutoFilter” and “Advanced Filter”.AutoFilter is 
readily available in the column headings when you have defined a table. Advanced Filter requires a little 
more work, but it also gives you more options. 

In practice AutoFilter is by far the easiest to use, and it can deal with most tasks. Advanced Filter is 
preferable if you want to filter your table based on values in cells outside of the table you are filtering. 

6.2.1	 AutoFilter

The AutoFilter is located at the top of the table in the headers. As you may have noticed, a button has 
appeared next to each heading. By clicking the buttons you will have access to AutoFilter.

In our exercise, we want the table to show pre-1990 Danish films. The approach is that we look at which 
columns contain data that we want to find. Then we take one column at a time and define the criteria for it.

1.	 Click on the arrow to the right of the header “Language”. 

A menu will appear, where you have different options relating to sorting and filtering the column, Do 
not choose any of the sorting options yet; we will look at that later.

Figure 55: Filtering options.
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In the menu that appeared you can also see a list of all the values you have typed into the ‘Language” 
column. In our case it is “Danish” “English” and “German”. At the moment there’s a “tick” next to all 
three values, which means we have not filtered anything out yet.

2.	 Click on the selection by Select All to make the markers disappear.
3.	 Then insert a marker by English. Now it should only be “English”, that is marked, as in 

Figure 60.
4.	 Click on OK.

You have created the first filter, so you are shown only Danish film titles. The other films are still there, 
but they are hidden at the moment. Notice the spreadsheet row numbers on the left side. Row 

Figure 56: Now only Danish film titles from the list are shown.

4, 5 and 7 are not displayed, and the rows that contain filtered data are shown in blue row numbers. When 
row numbers are blue, it means that a filter is active. 

It also means that you must think carefully if you want to create two tables with different filters side by 
side. Excel hides the entire row in the worksheet when a cell value does not satisfy a given criterion. So if 
you have a second table standing next to the table you are filtering, you may inadvertently hide data in it.

The aim of our exercise was to find pre-1990 Danish film titles, so we need to filter by year. To filter by 
year before 1990, we have to define a “custom filter”.

5.	 Click on the small arrow next to the header “Year”
6.	 In the menu that appears, point to Number Filters.
7.	 A submenu will appear. Click on Less Than to open a dialog box.
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Figure 57: The Filter “Less than”.

In the dialog box you must indicate that you want to see the rows of the table where the year is “less than” 
1990. The dialog box allows you to specify two different criteria, but in this exercise we only use one.
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Figure 58: Custom filter.

8.	 Fill out the dialog box as shown in Figure 58 and click OK.

Now we have used filters on the columns, “Language” and “Year”, and the result should look like Figure 59:

Figure 59: The result of our exercise with filters.

After all the hard work creating the filters we must remove them again. Fortunately, it is fairly easy, and 
it can be done in two ways. The first method is to remove the filters individually from each column. We 
will try with “Year”. 

9.	 Click on the filter button next to the header “Year”.
10.	 In the menu that appears, click on Remove Filter From “Year” 
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Figure 60: Remove a filter.

Now the two Danish movies in our collection are shown again. The other way of removing filters is used 
to remove all filters at once.

11.	 Make one of the cells in the table the active cell.
12.	 In the Ribbon, click the Data Tab.
13.	 Click the Filter button. It is easy to find because it will be yellow/orange at this point.

Figure 61: The filter button is easy to find.

The filters have been removed and all the rows in the table are shown again.

6.2.2	 Advanced Filter

The Advanced Filter works in a completely different way than the AutoFilter. In the Advanced Filter you 
must create an additional table named “criteria range” with the same column headings as the table that 
you want to filter. In the extra table you must specify the criteria and tell Excel where to find the criteria.

Finally, you must also indicate whether you want the table filtered by hiding rows, or by writing the 
results elsewhere in the spreadsheet. The latter option means you do not have any hidden rows.
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In this exercise, we continue working with the list of our small film collection. Again, it seems extremely 
foolish to filter a table with five rows, but it is easier to understand the different concepts when we only 
have little data to work with.

First we must make some space above the table for our Criteria Range. At least three blank rows above 
the table are required for the criteria range, since there are some rules that must be observed to make 
it work: 

-- The Criteria Range should have column headings, and it must be the same as the column 
headings in the table to be filtered.

-- The Criteria Range should have room for at least one row of criteria.
-- There must be at least one empty row acting as the space between the criteria range and the 

table to be filtered.

In this exercise, there should be room for three series of criteria, so we must have five blank rows above 
the table to make room for it all. We can either do this by simply moving the table four rows down, or 
by inserting four empty rows above it. We choose the latter.

1.	 Click with the right mouse button on the column heading for row “1”. A menu will pop up.
2.	 Click on Insert (Not to be confused with Paste).
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You have now added an empty row at the top. We need three more, but since I was born lazy and want 
to teach you some small tweaks, we will not repeat the same procedure again.

3.	 Hold the CTRL key on the keyboard down and press the Y key three times.

When you hold down the CTRL key and press the Y key, you use the command “Repeat last action”. 
It works for many commands, and in all MS-Office programs. It also works in many other programs.

Now your spreadsheet looks like this:

Figure 62: Now there is room for the criteria range.

Now we need some column headings for the criteria range, Since they are the same as in the table, we 
can just copy those.

4.	 Select cell region B6:F6.
5.	 Hold the CTRL key on the keyboard down and press the C key.
6.	 Activate cell B1.
7.	 Hold the CTRL key on the keyboard down and press the V key.

Your spreadsheet should now look like Figure 63:

Figure 63: The criteria range with column headings.
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Now we can define some criteria, but I would like to try to explain how the criteria range works, because 
it is not always easy to grasp.

As mentioned, the criteria range is designed as a table with rows and columns. The columns have headings 
that correspond to those in the table that is to be filtered according to the criteria. There is obviously a 
reason why you can write multiple rows of criteria, namely that you can put “AND” or “OR” between 
the criteria.

Criteria with “AND” in between are placed in the same row Criteria with “OR” between are placed in 
separate rows. 

An example in our table could be that we want to display rows in the table containing films that are 
Danish AND prior to1990.

8.	 Type the word “Danish” in cell D2.
9.	 Type “<1990” in cell E2 (means “less than 1990”).

10.	 Activate another cell in the table you want to filter, for example C7.
11.	 Choose the Data Tab in the Ribbon.
12.	 Click on the Advanced button in the Ribbon. 

Figure 64: The Advanced button.

This opens the Advanced filter dialog box, where you must define what is to be filtered and where the 
criteria are.

13.	 Make sure that Filter List Locally is selected. This means that the filter, like AutoFilter is 
hiding the rows that do not meet the criteria.

14.	 The field List Range has probably been inserted automatically. It should say “$B$6:$F$11”, 
which is the cell region we are going to filter.

15.	 In the field Criteria Range you must delete what you have previously inserted, since 
it is often wrong. With the mouse, mark cell region B1:F2. It should now say “ ‘SHEET 
1’!$B$1:$F$2” in this field. Do not get confused when it says “ ‘Sheet1’!” in front of the cell 
reference. That is because it is possible to work in multiple sheet tabs in Excel, although we 
do not for this exercise.

16.	 Click OK.
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This gives the result “Midt om Natten”, which is the only film title that fulfils both criteria (Figure 65). 

Figure 65: Two criteria with AND between.

Another example could be that we wish to view the rows in the table containing either Danish films OR 
pre-1990 film titles. In other words, we want to view all the Danish film titles and all pre-1990 films.

Figure 66: The Clear button.
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17.	 In the Ribbon, click the Clear button, which will cancel the filtration.
18.	 Erase contents in cell E2.
19.	 Type “<1990” in cell E3.
20.	 Select a cell in the table you want to filter and click on the Advanced button in the Ribbon.
21.	 Fill in the dialog box as previously shown, but this time the Criteria Range is 

“ ‘SHEET1’!$B$1:$F$3”, since we have several criteria .
22.	 Click OK.

This gives us three rows, “Midt om Natten” which is Danish, “Blinkende Lygter”, which is also Danish, 
and “Scarface”, which is not Danish, but which is from before the year 1990 (Figure 67). Each film need 
only meet one of the listed criteria when it says OR between them.

Figure 67: Two criteria with OR between.

You can also combine. If you want the filtered table to show films that are EITHER Danish AND prior 
to 1990, OR all films after 1990, it looks like this: 

Figure 68: Three criteria with a combination of AND and OR.

When you combine AND and OR it is important to know the math behind. When you type in two 
rows of criteria, all the criteria in the same row should be considered one large criterion. Thus in our 
last example we had two criteria of which the first criterion was a combination of two criteria that both 
had to be fulfilled.
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Figure 69: The year is based on a formula. Note the Formula Bar.

6.2.3	 Advanced Filter with Formulas

When using the advanced filter, you are not limited to manually having to write the criteria every 
time. You can also write equations where the outcome serves as a criterion in the filter. For example, if 
you had to extract values from a table with a filter which is based on a calculation either directly in the 
filter or as a result of a complicated calculation elsewhere in the spreadsheet or workbook.

In our previous exercise, you might wish to change to a year in cell H2, which you import to cell E2 
using the formula “=H2”.

If you run the filter, the movie with the year 1990 will be the only one that meets the criterion. But what 
if you want to view the list of all movies from before the year 1990? This requires that it says “<1990” 
in the criterion, but how is that done with a formula? 

The answer is that you must use what is called a “text string”. As you may be aware, Excel knows the 
difference between numbers and text. If you want a formula to display text, the text must be surrounded 
by double quotes.

In our formula, we need to show text in the form of “<” and a number based on the content in cell 
H2. This is done by typing = “<” & H2 in cell E2. In principle the formula should show only two different 
values, and when you have to do something like that you always have to separate the different values 
with an & symbol.

Figure 70: The Filter with a slightly more advanced formula. Again, notice the Formula Bar.
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When you write a formula where you use the & symbol to display multiple values in succession, Excel 
will always consider the result as a piece of text. One would expect that to cause problems when we 
want to filter according to numbers, but in this case Excel is clever enough to figure out what you mean.

6.3	 Sorting

Of course you can also sort by the various columns in the table. Like so much else in Excel, there is a 
simple and a complicated way of doing so.

We are working with the same table that we used when we were working with filters. But since we do 
not need filters anymore, I have deleted the top four rows in order to save a little space. You can do the 
same if you want, but it is not required. 

First we will sort the list so the films appear in alphabetical order 

1.	 Make one of the cells in the column “Title” the active one.
2.	 Ensure the Data Tab has been selected in the Ribbon 
3.	 Click on the Sort A–Z button to sort in ascending order. 
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Figure 71: The Sort A–Z button.

Now the list has been sorted alphabetically.

Figure 72: The table has been sorted according to title.

That was the simplest method for sorting. But you can also sort multiple columns at once, by ranking 
columns according to what must be sorted first.

In the following exercise we want to sort by language first, then by year.

4.	 Activate one of the cells in the table. It does not matter which one you choose.
5.	 Click on the Data Tab in the Ribbon, then click on the Sort button.

A dialog box appears, where you must specify which columns you want sorted, and what level each 
column should be sorted by in relation to each other.

Figure 73: The dialog box “Sort”.
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6.	 In Figure 73 you can see what you must choose. You should sort the column “Language”, 
according to values in ascending order

7.	 Click on the Add Level button to specify another sorting level.

Figure 74: The second sorting level is being defined.

8.	 Choose as shown in Figure 74 and click OK.

The table now looks like this:

Figure 75: The table has been sorted by language and year.

The Films have now been sorted by language and year.

You have now learned the basics about filtering and sorting tables. Now we need to try some slightly more 
advanced features, since it goes without saying that Excel can perform calculations on such a table as well.

6.4	 Pivot Tables

To “Pivot” means something like “turning around a centre.”  In Excel we use pivot tables to do some 
sophisticated summaries and calculations on an existing table.  You are able to very quickly analyse 
different things from different perspectives.  That is probably why Microsoft has chosen to call them 
“pivot tables”. 
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We will continue working with our movie file, where we will now make some quick calculations with 
a pivot table.

1.	 Make one of the cells in the table the active one. Another Tab will appear in the Ribbon 
called Design.

2.	 Click on the Design Tab in the Ribbon.
3.	 Click on the Summarize With Pivot Table Tab in the Ribbon.

Figure 76: The Summarize with Pivot Table Tab.

4.	 Leave the settings as they are and click OK.

Now we have created an empty pivot table and are ready to feed it information. But first, we have to take 
a look at the pivot table’s work range.

Figure 77: Work area when working with pivot tables.
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The work area consists of three essential elements:

•	 The actual pivot table that shows the result of our choices.
•	  A field list, where we choose what data to use in the pivot table. When we work with pivot 

tables a “field” corresponds to a column in the table that we pull data from. The field list 
contains the equivalent to the columns in our directory.

•	 An area for placement of fields from the field list. The pivot table’s look and performance 
depends on how we place the fields in these four windows. Fields to be placed in the 
window “Column Labels” will form a number of columns in the pivot table corresponding 
to different values in the table. The same is the case for the series labels. Fields to be placed 
in the window “Values” will be the cells used for calculations in the pivot table. Finally, there 
is the pane “Report Filter”. It can be used for selecting data from the table based on various 
criteria.

 

  

 

                . 
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Figure 78: Drag using the mouse.

To make calculations, we must drag some fields from the field list to the area for placement of fields.

5.	 Point to the field Running Time In Minutes in the field list.
6.	 Click with the left mouse button and hold it down while dragging the field down to the 

Values pane. Now, release the mouse button. Refer to Figure 78.

The pivot table now displays the sum of the running times for all movies in the directory. 

We could also have done that using a simple formula, so let us try something a bit more advanced.

7.	 Drag the Language field into the “Row Labels” pane.

Figure 79: Total running time for each language.

Now you have a sum of running times for each language. Do you see the trick?
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Of course, Excel can do more than calculating sums. You can also get the number of movie titles, or you 
can calculate averages, running sums, and even standard deviation and variance, if you need it

8.	 Double-click on cell B3, which is the column label “Sum of running time in minutes.”

Figure 80: Settings for the value field.

A dialog box appears (Figure 80), where you can choose what the pivot table should do about the 
numbers. You can change what should be in the column label, and you can select what should be counted 
out. There is also the option to change number format by clicking the Number Format button

9.	 Click Number on the list, and then OK.

Now the pivot table shows that we have two Danish, two English and a German film in our directory. In 
this context, it does not matter if we have used the field “Year” or any other field. With the “Number” 
feature Excel simply notes that there is a value, and counts it as 1. 

10.	 Drag the field Year from the field list into the “Column Labels” pane.

Figure 81: Now the years have become column labels.
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You now have an overview of how many movies you have in each language from different years. The 
pivot table automatically inserts totals to the right and bottom. Maybe that is not the best way to display 
it, so it is fortunate that we can have multiple row and column headings at the same time.

11.	 Drag the field Year down into the Column “labels” pane. Thus there will be two fields in this 
pane, and Year will disappear from the “Column Labels” pane.

It now looks like this:

Figure 82: Two column labels.
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Be aware that labels are tiered. In the pane “Row Labels” you have language at the top, and so the pivot 
table will group data by language first, then year.  By default Excel inserts a “Subtotal” of the overall 
levels. For example, it says “2” next to the “English” label. This is very smart, but it can also be a problem 
if later you need to work with data elsewhere. You can omit the subtotals by clicking the right mouse 
button on one of the labels (e.g. cell A7) and click on Subtotal for “Language”.

Figure 83: Pivot table with report filter.

As is the case with row labels, you can also have column labels in several levels. My experience is that it 
is only something you should do in an emergency, as it tends to get confusing. You can also drag multiple 
values into the “Values” window, but I believe you would find that quite unmanageable. It is better to 
make an extra pivot table or to use the kind of filters I will describe for you next 

Notice that there is a small button in cell A3. By using that you can create a filter exactly like an AutoFilter 
in a common table. If you want to, you can experiment with it yourself.

There is also another filter option for pivot tables.

12.	 Drag the field Protagonist down into the pane “Report Filter”.

Now an extra filter is placed on the pivot table.

13.	 Click on the button B1 and choose Al Pacino.

This will ensure that only data in which Al Pacino is the protagonist will be displayed. In this case it is 
only one film.
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6.4.1	 Preserving Results

Once you have set up a pivot table and used some filters, you might want to preserve the calculation 
that you made, even if you also want to continue working with the pivot table. You can copy the pivot 
table to another location, so you have two pivot tables to work with. You can also, once you have copied 
the table to the clipboard, choose to insert the table somewhere else as “values”. This clears it of all pivot 
functionality, and it can be treated as pure data with no risk of further changes.

6.4.2	 A Couple of Tips on Pivot Tables

Pivot tables are an excellent tool for analysing and summarising large amounts of data, but you can also 
quickly lose track if you “bury” the table in too many labels on several levels. 

It is a good idea to take small steps when you build a PivotTable. Start with the value field and then 
insert some row labels. Finally insert the column labels. This is the approach that best ensures that you 
have an overview of the table throughout the construction phase

Consider what should be row labels and what should be column labels before you begin. A field with 
many different values will provide as many labels, while a field that can have only three different values 
will only create three labels.

In my experience it is best to use fields with few values as column labels and let the fields with many values 
be row labels. If you have many column labels, the table quickly becomes very wide and thus confusing.

If you need to do a complex pivot table where you have to have labels at multiple levels, you may wish 
to consider the use of filters. Otherwise, you can decide whether it is better to make two different pivot 
tables that are manageable in isolation, instead of one big confusing table.
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